Using EndNote Online to Manage your References

Workbook

Edition 5
October 2017
Document Reference: 3814-2017
Using EndNote Online to Manage your References

Contents

1. Create an EndNote Online Account ................................................................. 1
2. Collect .................................................................................................................. 2
   Type a Reference .................................................................................................. 2
   References from DiscoverEd ............................................................................... 3
   References from PubMed .................................................................................... 4
   References from Google Scholar ....................................................................... 5
3. Organize .............................................................................................................. 6
   Attachments ......................................................................................................... 6
   Groups .................................................................................................................. 7
   Sharing Groups .................................................................................................... 8
4. Format .................................................................................................................. 9
   Export a Bibliography ......................................................................................... 9
   Configure Cite While You Write ....................................................................... 10
   Cite References in Word .................................................................................... 11
   Edit Citations ....................................................................................................... 12
   Delete Citations .................................................................................................. 13
5. Further Information and Support ..................................................................... 14
   EndNote Online Resources Wiki Page ............................................................. 14
   Styles .................................................................................................................. 14
   Assemble a Long Document ............................................................................. 14
   Helpline ............................................................................................................... 14

If you require this document in an alternative format, such as large print, please email is.skills@ed.ac.uk.

Copyright © Information Services, University of Edinburgh 2017

Permission is granted to any individual or institution to use, copy or redistribute this document whole or in part, so long as it is not sold for profit and provided that the above copyright notice and this permission notice appear in all copies.

Where any part of this document is included in another document, due acknowledgement is required.
1. Create an EndNote Online Account

Register for your free EndNote Online account via Web of Science to make sure it is associated with the University of Edinburgh. This will give you access to the University's many bibliographic output styles.

1. To set up your account, follow this link to Web of Science: [http://wok.mimas.ac.uk.ezproxy.is.ed.ac.uk/](http://wok.mimas.ac.uk.ezproxy.is.ed.ac.uk/)

Log in with your EASE account if prompted.

2. Click on the **Click here to access Web of Science** button.

3. Click on the **EndNote** link at the top of the page.

4. You will be asked to sign in with Endnote – click on the **Sign up** link.

5. Follow the instructions to create an account.

You can now sign in to EndNote Online using the email address and password you registered.
2. Collect

Type a Reference

Typing references into EndNote Online is the simplest way of adding references, but it is also the most time consuming.

This method of collecting references is most useful when:
- You only want to add a few references.
- Or, the references you want to add are not available in an online database.
- Or, if finding them in an online database will take longer than typing them.

1. Log in to EndNote Online at [www.myendnoteweb.com](http://www.myendnoteweb.com)

2. Click on the Collect tab, then New Reference.

3. Choose the Reference Type from the menu and fill in the Bibliographic Fields.

Make sure you enter authors in the format “Last Name, First Name”, and that you enter each author’s name on a new line.

You do not have to fill in all the fields, but at the least type in the details needed to cite the reference accurately and completely.

4. Click Save when you are finished.

5. Click on All My References in the panel on the left to view the reference you have just entered in your library.
References from DiscoverEd

You can add references to your library by exporting them from DiscoverEd, the University of Edinburgh’s Library discovery service. Adding references in this way is quicker than typing them in and the references often contain extra information such as abstracts or keywords.

1. Open http://discovered.ed.ac.uk in your web browser and run a search.
2. Click on the Show all actions options (three dots) button to the right of the reference you want to add to your EndNote library.
3. Choose EndNote Web.

EndNote Online will open in a new tab with a confirmation that the record has been imported.
4. Go to the My References tab to view the reference you exported from DiscoverEd.

Exporting multiple references

1. If you want to add several records from DiscoverEd click the Add to this item to My Favourites (drawing pin) button in the search results list to collect them.
2. Then click Go to My Favourites (drawing pin button at top right of page).
3. Select the records and click on Export/Email selected items (three dots button above the list).
4. Finally click EndNote Web to send them all to EndNote Online.

Tip: You can export references from most online databases to EndNote Online (not just DiscoverEd), but the method for doing this depends on the database. See the EndNote Online Questions Answered wiki page https://www.wiki.ed.ac.uk/x/LZ8DCg for instructions about how to export references from some of the most commonly used databases, or contact the IS Helpline if you need help exporting references from a particular database (see “Further Information and Support” on page 13 of this workbook for the Helpline’s contact details).
Using EndNote Online to Manage your References

References from PubMed

Importing references from PubMed is not as straightforward as importing them from DiscoverEd. You need to save the references in a correctly formatted file, then use EndNote Online’s Import option.

2. Tick the boxes to the left of the references that you want to add to your EndNote Online library.
3. Click the Send to menu at the top of the page. Select the File radio button and choose MEDLINE from the Format menu.
4. Click the Create File button.
5. The file will be downloaded. Save it if prompted.
6. In your EndNote Online account, go to the Collect tab and choose Import References.
7. Click on the Browse button and select the file you just downloaded. This will probably be called pubmed_result.txt and be located in your Downloads folder. Click Open.
8. Choose PubMed (NLM) from the Import Option menu.
9. Use the To menu to choose a group to add the reference to, or choose [Unfiled].
10. Click the Import button. A confirmation message will appear telling you how many references were imported into which group.
11. Click on the My References tab to view all of the references in your library.
References from Google Scholar

It is possible to save references from Google Scholar as an EndNote file, then import them into EndNote Online. It is only possible to import one reference at a time from Google Scholar.

1. Go to the Google Scholar website [http://scholar.google.co.uk](http://scholar.google.co.uk)
2. Click on the options (three lines) button at the top left of the page and choose **Settings**.
3. In the **Bibliography manager** section, select **Show links to import citations into** and choose **EndNote** from the menu.

4. Click **Save**. You will return to the Google Scholar homepage. Enter your search terms and click the search (magnifying glass) button.
5. Click the **Import into EndNote** link below the reference that you want to add to your EndNote Online library.

6. A file will be downloaded, save if prompted.
7. In your EndNote Online account, go to the **Collect** tab and choose **Import References**.
8. Click on the **Browse** button and select the file you just downloaded. This will probably be called **scholar.enw** and be located in your **Downloads** folder. Click **Open**.
9. Choose **EndNote Import** from the **Import Option** menu.
10. Use the **To** menu to choose a group to add the reference to, or choose **[Unfiled]**.

11. Click the **Import** button. A confirmation message will appear telling you how many references were imported into which group.
12. Click on the **My References** tab to view all of the references in your library.
3. Organize

Attachments

EndNote Online includes 2GB of space for saving attachments, such as full text PDFs, to references.

To add an attachment to a reference:

1. Click on the My References tab and find the reference you want to attach the file to. Click on the View file attachments button (paperclip) below the reference title.

2. Click on the Attach files link.

3. Select the file(s) you would like to upload using Browse, then click Upload.

4. Wait until the upload is complete, then click Close.

5. Close the File Attachments window using the button (x) at the top right.

The View file attachments button (paperclip) will turn blue to indicate that the reference has an attachment.

To open a file attachment:

6. Click on the My References tab and find the reference with the attachment you want to open. Click on the View file attachments button (paperclip) below the reference title.

7. Click on the name of the attachment you want to open.

To manage your attachments:

8. Click on the Organize tab, then on Manage Attachments.

A list of all the attachments in your library will be displayed. You can delete and open attachments from here.
Groups

EndNote Online allows you to put references into groups. References can be in more than one group. If a reference is not in any group it appears in Unfiled.

To create a group:
1. Click on the Organize tab.
2. Click on the New Group button.
3. Give the group a name and click OK.

To add references to your group:
4. Click the My References tab.
5. Select the boxes next to the references you want to group and choose the group name from the Add to group… menu.

The panel on the left will update to show the number of references in the group:
Sharing Groups

EndNote Online allows you to share your groups with other EndNote Online users.

1. Click on the Organize tab.
2. Tick the Share box next to the group you want to share, and click the Manage Sharing button.

3. Click the Start sharing this group link.

4. A pop up window will open. Enter the email addresses of the people you want to share the group with. You can also choose whether you want them to have Read only or Read & Write access to the group.

5. When you have finished click Apply.

A message should appear at the top of the window to say that the email address(es) have been added.

6. Close the window.

An icon appears next to the group on the My References tab to show that it is shared.
4. Format

Export a Bibliography

If you don’t want a document with automatic in-text citations you can simply export your references as a bibliography or reading list.

1. Click on the Format tab.
2. Select the references you want in your bibliography in the References menu. This can be a group or all the references in your library.
3. Select the Bibliographic Style.
   If there are a few styles you use regularly you can click Select Favorites and create a custom menu.
4. Select RTF (rich text file) from the File format menu. Click the Save button.
5. When prompted, open the file. It will contain a bibliography of the references in the selected style.
Configure Cite While You Write

Cite While You Write is a plugin that allows you to use EndNote Online to insert citations and bibliographies in Microsoft Word documents.

You should only need to install and configure Cite While You Write once.

1. Open Microsoft Word and look for an EndNote tab.

2. If there is an EndNote tab skip to step 3. If there is no EndNote tab please follow steps a. & b. below.
   a. Go to EndNote Online, click on the Downloads tab.
   b. Download and install the Cite While You Write plug-in for your system (Windows or Macintosh).

3. Go to Word and click on the EndNote tab. Click on Preferences.

4. Click on the Application tab and choose EndNote online from the Application menu.

5. Enter your email address and EndNote Online password and click OK.

You are now ready to add your EndNote Online references to your Word document.
Cite References in Word

Once Cite While You Write has been installed and configured you are ready to start using it to add your references to Word documents. Once you have added references it is easy to change their appearance using EndNote Online’s bibliographic styles.

1. Place the cursor at the point in your Word document where you want an in-text citation.
2. Go to the EndNote tab in Word. Click on the Insert Citations button in the Citations group.
3. Enter a search term and click Find.
4. Select the citation you want to insert and click the Insert button.

The citation will be placed in the text and the full reference will be listed at the end of the document.

It is easy to change the appearance of your in-text citations and bibliography using EndNote Online’s many bibliographic styles.

5. Select the style you want to use from the Style menu in the Bibliography group of the EndNote tab. You may need to choose Select Another Style… at the top of the menu if the style you want does not appear in the list.

Your in-text citations and bibliography will be automatically re-formatted in the selected style.
Edit Citations

If you want to edit a citation (for example remove the author’s name, remove the year, or add page numbers) you should use the Edit Citation(s) button.

If there is an error in a citation or the bibliography (for example the author’s name is misspelt) this should be corrected in EndNote Online.

To edit a citation:
1. Click on the Edit Citation(s) button in the Citations group on the EndNote tab.

The EndNote Edit & Manage Citations window will open.
2. Select the citation you wish to edit from the list. Note that the same reference may be cited more than once.
3. Use the tick boxes to exclude the author or year.
4. If you want page numbers to appear in the citation enter them in the Pages box.

Please note that not all styles support page numbers – if you are using one that doesn’t then you can add any text you want to appear after the citation in the Suffix box.

5. When you are finished click OK.

To correct an error in a reference:
6. Go to EndNote Online in your web browser.
7. Click on the title of the reference that contains the error. Correct the error and click Save.
8. Switch back to your Word document and click on the Edit Citation(s) button on the EndNote tab.
9. Select the citation that needs updating from the list. Click on the arrow to the right of the Edit Reference button and choose Update from My Library…

10. Make sure that the correct (updated) reference is selected (you may need to run a search). Click Insert, then OK.
Delete Citations

Don't just press the delete key if you want to remove a citation - hidden parts of the citation may remain and corrupt your document. The correct way to completely remove a citation from your Word document is as follows:

1. Click on the citation that you want to delete.
2. Click on the Edit Citation(s) button on the EndNote tab in Word.

3. A window will open - make sure the correct citation is selected, then click on the down arrow to the right of the Edit Reference button next to it. If you have a smaller screen you may need to scroll to the right to see this arrow.

4. Choose Remove Citation from the menu.
5. Click OK.

Tip: This will only remove the selected citation from your document. If you have cited the same reference more than once then the other citations will still be there.
5. Further Information and Support

EndNote Online Resources Wiki Page

Visit our wiki page for links to resources including videos, courses and a list of “Questions Answered”: https://www.wiki.ed.ac.uk/x/LZ8DCq

Styles

If the citation style you need is not available in EndNote Online please contact IS.Helpline@ed.ac.uk giving details of the style required and the University of Edinburgh’s EndNote Online administrators should be able to upload it for you.

Assemble a Long Document

If you want to combine two or more Word documents containing EndNote citations into a single document (for example, thesis chapters) you should un-format the EndNote citations before combining the documents. After the documents have been combined you can reformat the citations and a single bibliography will be created at the end of the document.

To un-format the EndNote citations in a document:

Click on Convert Citations and Bibliography on Word’s EndNote tab.

• Choose Convert to Unformatted Citations.

To reformat the citations once the documents have been combined:

• Click on Update Citations and Bibliography on Word’s EndNote tab.

Helpline

If you have any problems using EndNote Online please contact the Information Services’ Helpline:

• Web: Self-service portal http://ed.unidesk.ac.uk/tas/public (preferred)
• Email: IS.Helpline@ed.ac.uk
• Phone: +44 (0)131 651 5151
• Availability: IS Helpline is open 24 hours a day, 7 days a week